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1. Introduction 

1.1. Overview 

This document provides information on the LTE Data Throughput Test Packs. You will 
become familiar with the Test Pack Suites, Test Cases, and setting up LTE testing 
scenarios in the Test Manager environment by following the step-by-step procedures and 
test reference documentation. 

1.2. Intended Audience 

This manual is intended for those who have a working knowledge of wireless 
communication equipment, and are familiar with the automated testing of mobile 
devices. It is assumed that the audience is familiar with the Test Manager GUI 
environment. Those who are unfamiliar with the Test Manager should refer to the Test 
Manager User Manual before proceeding further. 

1.3. Before You Get Started 

Before getting started with this guide, install all software and power up the test system. 
The controller PC is shipped with the Test Manager Test Executive software and LTE - 
Data Throughput Test Packs installed. 

1.4. Security Information 

The LTE – Data Throughput Test Packs are shipped with the appropriate dongle and 
software/hardware security passwords configured. 

To verify the security information: 

1. Open Test Manager and select Help>About. 
The About Test Manager window displays, as shown in Figure 1-1. 
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Figure 1-1: About Test Manager Window 

2. Select the Passwords tab. 

3. Under Installed Features, confirm the LTE – Data Throughput Test Packs are 
installed, as shown in Figure 1-2. 

 
Figure 1-2: About Test Manager Window – Installed Features 

Password authentication is a pre-requisite to running any tests supported by these Test 
Packs. This password is tied to security information provided by the USB hard-lock 
dongle that comes with the module installation. 

For an SVLTE test, confirm the SVLTE – Data Throughput Test Pack is installed, as shown 
in Figure 1-3. 
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Figure 1-3: About Test Manager Window — SVLTE 

If Advanced Channel Models is enabled using SR5500M, confirm the Data Throughput 
Test Pack 2 is installed, as shown in Figure 1-4.  

 
Figure 1-4: About Test Manager Window – Test Pack 2 

NOTE: To use the SR5500 for the Advanced Channel Models test, the following 
minimum options must be purchased:  
• AWGN  
• Complex Correlation 
• MIMO 
• GCM 

For the Variable Reference Channel feature, confirm the Data Throughput Test Pack 3 is 
installed and authorized with the corresponding password, as shown in Figure 1-5. 



4 | 8100: Data Throughput – LTE User Manual 

 
Figure 1-5: About Test Manager Window – Test Pack 3 

If you have any questions or concerns, contact Spirent Technical Support at 
support.spirent.com, or by phone at 1-800-SPIRENT. 

1.5. Accessing Documentation 

There are two ways to access this document from the Controller PC: 

1. Windows Explorer 

2. Test Manager 

1.5.1. Accessing Documentation from Windows Explorer 

Access this Manual offline by navigating to C:\Program Files\Spirent 
Communications\Test Manager\Modules\Data Throughput - LTE\User Manual.pdf” 
using Windows Explorer, as shown in Figure 1-6. 
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Figure 1-6: Accessing the Manual from Windows Explorer 

1.5.2. Accessing Documentation from Test Manager 

Access this Manual from the Test Manager menu by selecting: 
Help>Modules>Data Throughput - LTE>User Manual.pdf, as shown in Figure 1-7. 

 
Figure 1-7: Accessing the Manual from Test Manager 

 



2. Data Throughput – LTE Description 

2.1. Overview 

This chapter provides a high-level overview of the key software and hardware 
components necessary to configure and use the Data Throughput – LTE Test Packs. 

2.2. Description 

The Data Throughput - LTE Module is an integrated software component that allows you 
to perform interactive and automated testing of mobility scenarios on a UE device. 
Support is provided for: 

• LTE Bands: 1, 2, 3, 4, 5, 7, 10, 12, 13, 14, 17, 20, 24, 25, and 26. 

• LTE Bandwidth: 1.4, 3, 5, 10, 15, and 20.  

NOTE: 1.4M, 3M, 15M and 20MHz bandwidths and Band Classes 1, 2, 3, 5, 12, 20, 
24, 25, and 26 have not been fully validated. 

The Data Throughput - LTE module test cases run with the Test Manager software. This 
provides an easy way to automate test sessions with analysis and reporting capabilities.



3. Using the Data Throughput – LTE Test Packs 

3.1. Overview 

This chapter gives information on using Data Throughput – LTE from Test Manager.  

This includes the following steps: 

1. Configuring the Platform Parameters 

2. Configuring the UE Parameters 

3. Configuring the Session Parameters 

4. Selecting the Parameter Files for Session Execution 

5. Locating the Test Cases 

6. Creating a Custom Test Suite 

7. Configuring Test Case parameters 

8. Running a Test Suite 

9. Setting up a New UE with the Data Client 

3.2. Configuring the Platform Parameters 

3.2.1. Supported Platforms 

The Data Throughput – LTE Test Packs support the following platforms: 

• 8100-B Series 

3.2.2. 8100-B Series Platform Parameters 

The parameters for the 8100-B Series platform configure the technologies present in the 
system, as shown in Figure 3-1. Set the SR3452 Enabled parameter to True to support 
CDMA/EV-DO. Set the SR3420 Enabled parameter to True to support WCDMA/GSM. Set 
the E2010S Enabled parameter to True to support LTE.  

NOTE: The platform parameters will be correctly configured when the system is 
delivered. It should not be necessary to modify them. 
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Figure 3-1: 8100-B Series Platform Parameters 

For SVLTE, set the parameters as shown in Figure 3-2. To support SVLTE, set the SR8078 
and SR3452 #1 to True if the configuration is 1eNodeB and 1BSC. 
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Figure 3-2 :8100-B Series Platform Parameters for SVLTE 

For Advanced/Dynamic Channel Models using SR5500M, set the E2010S CE Enabled 
and SR5500 #1 Enabled to True, as shown in Figure 3-3.  
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Figure 3-3: 8100-B Series Platform Parameters for Advanced/Dynamic Channel Models 

NOTE: If SR5500M Enabled is set to True, test cases can be run with 
Advanced/Dynamic Channel Models enabled or disabled without having to change 
any cables.  
If SR5500M is set to False, Advanced/Dynamic Channel Model test cases are not 
supported. 
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3.3. Configuring the UE Parameters 

The level of automation and reliability of the system is heavily dependent on the ability 
of the system to control the UE. UE parameters are configured to facilitate these 
activities. 

3.3.1. UE Interface Parameters 

The UE interface parameters specify how the UE is controlled during test case execution. 
The options for the UE Control Method are: 

• Manual: The system prompts the operator to perform actions on the UE. 

• AT: The system issues the specified AT commands to control the UE. 

• Custom: (Advanced) Allows custom UE control. If Custom is selected, the UE Control 
Sequence File parameter specifies the Control Sequence file used by the system. 

The ability of the system to return the UE to a known state before execution of a test case 
is important. If the UE supports a reliable reset command, set the Reset for Ensure Idle 
parameter to True. 

 
Figure 3-4: UE Parameters Window – UE Interface Parameters 

NOTE: In cases where the UE Control Method is set to anything other than Manual, 
the Manual method will be attempted as a fallback if a command fails or is not 
provided. 
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3.3.2. UE Manual Interface Parameters 

If the UE Control Method parameter under the UE Interface tab is set to “Manual”, if a 
command fails, or is not provided by the selected UE Control Method, the parameters of 
the UE Manual Interface are used. In this case, a window displays prompting you to 
perform the necessary action on the UE. 

• Timeout Parameters: Specifies how long the system waits before automatically 
selecting the defined Timeout Button. The timeout value is selected from a drop-
down box providing a range from "Disabled" to "Indefinite." A value of "Disabled" 
indicates no user prompt will be displayed and testing will proceed as if the UE 
control was completed successfully. A value of “Indefinite” indicates the function 
will wait indefinitely. Note that even if Manual control is not selected, it may be used 
in case of failure. If the timeout value is set to “Indefinite”, the system will wait 
indefinitely, which may not be desirable. 

• Timeout Button Parameters: If a timeout other than "Disabled" or "Indefinite" is 
specified, these parameters specify if the OK or Cancel button is selected when the 
timeout expires. 

 
Figure 3-5: UE Parameters Window – UE Manual Interface Parameters 

Configuring these parameters correctly can be effective in allowing some level of 
automation; even if AT commands are not available or supported for the UE under Test.  
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For example, if the UE can be configured to auto-answer an incoming call, you can set 
the timeout for Answer Voice Call. This allows the UE time to auto-answer the call, and 
the Timeout Button for Answer Voice Call can be set to OK. This configuration allows the 
device to reliably answer network-initiated voice calls. 

3.3.3. UE AT Interface Parameters 

If the UE reliably supports AT commands, AT control can be very useful. The UE is 
connected to the Data Client PC for AT control after the manufacturer's driver software is 
installed.  

The following parameters are provided: 

• Client IP Address: Set this parameter to the IP address of the Data Client PC. NOTE: 
The default address 192.168.0.61 should not be changed. 

• Primary COM Port Settings/Secondary COM Port Settings: These parameters 
configure the standard serial port parameters. 
Two COM ports can be used for different commands. For example, if two UE are used 
to test SVLTE, one COM port for LTE UE and another for 1xRTT UE. 

NOTE: The Data Throughput– LTE; Test Packs only make use of the Primary COM Port. 
The Data Throughput – SVLTE; Test Packs make use of two COM Ports. 

 Port – Set this parameter to the port on the Data Client PC assigned to the 
modem when the UE is connected. 

 Bits Per Second – Configure the baud rate. 

 Data Bits – Configure the number of data bits. 

 Parity – Configure the parity. 

 Stop Bits – Configure the stop bits. 

 Flow Control – Configure the flow control. 

 Enable DTR – Enables Data Terminal Ready Signaling. 

 Enable RTS – Enables Request To Send Signaling. 

 New Line – Specifies the new line terminator to use. 

• Commands – Configure the available AT command strings. 

• Test AT Commands – Use this wizard to test AT commands to check if the UE 
responds correctly and reliably before testing. 
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Figure 3-6: UE Parameters Window — UE AT Interface Port Parameters 
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Figure 3-7: Parameters Window – UE AT Interface AT Command Parameters  

NOTE: There is great variability in the AT commands supported by UE vendors and 
how reliably they work. Experimentation may be necessary to determine the best 
settings. 



16 | 8100: Data Throughput – LTE User Manual 

 
Figure 3-8: UE Parameters Window – Test UE AT Commands 

3.3.4. Spirent Data Client Parameters 

The Spirent Data Client Parameters tab, shown in Figure 3-9, allows you to configure 
some UE parameters relative to the Spirent Data Client. 

 
Figure 3-9: UE Parameters Window -— Spirent Data Client 
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The following parameters are provided: 

• Connection Mode: Specifies how the UE sets up the data connection. There are 
currently four modes supported: Dial-up Networking, Network Interface Card, Internet 
Connection Sharing, and Wi-Fi. 

• Connection Verification Type: Specifies how to verify the establishment of the 
connection when the connection mode is Network Interface Card, Internet 
Connection Sharing, and Wi-Fi. 

• MTU Size: Specifies the MTU Size of the UE under test in bytes.  

• Interface Identification Method: Specifies the method the Spirent Data Client uses 
to identify the UE Network Interface on the Client Laptop. 

• Device Interface Name: Specifies the device interface name in the route table. This 
name can be obtained by typing "route print" in the Command Prompt on the Client 
Laptop when the UE is connected. 

NOTE: The Device Interface Name has to be exactly the same as indicated on the 
client laptop, including any spaces. 

• Shell Commands: Specifies certain shell commands if an AT command is not used. 
These shell commands can be executed on the Client Laptop before registration, 
before setting up data call and after ending a data call. If the shell command is 
empty, nothing will be executed. 

• FTP Options: Specifies how the Spirent Data Client initiates the FTP data connection. 
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3.3.5. UE Capability Parameters 

UE Capability parameters configure the security and authentication settings for the UE as 
shown in Figure 3-10. These parameters also include configuring the PDN number and 
properties, as shown in Figure 3-11. 

The following parameters are provided for security and authentication settings: 

• AS Security: AS Security settings 

• NAS Security: NAS Security settings 

• NAS Authentication: NAS Authentication settings 

• HSS Settings: HSS Settings 

 
Figure 3-10: UE Parameters Window –Security and Authentication Parameters 
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The following parameters are provided for configuring PDN number and PDN properties: 

• PDNs: Parameters for supported PDNs. 

• PDN [N]: Specifies valid PDN settings. 

• IP Address Type: Specifies the type of IP address the UE will request. Valid Values: 
IPv4, IPv6, IPv4v6. 

• APN: Specifies the Access Point Name (APN) the UE will communicate with. 

• Services: Parameters for mapping services to PDNs. 

• Service [N]: Parameters for mapping the service to the PDN. 

• Service: Specifies the service. Valid Values: Administrative, Application, IMS, and 
Internet. 

• PDN: Specifies the PDN that carries this service. 

 
Figure 3-11: UE Parameters Window – UE Capability Parameters for PDN 

NOTE: There is great variability in the AT commands supported by UE vendors and 
how reliably they work. Experimentation may be necessary to determine the best 
settings. 
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3.4. Configuring the Session Parameters 

3.4.1. Session Control Parameters 

Session Parameters control the execution of the session as shown in Figure 3-12. 

• Rerunning Test Cases: These parameters control the automatic rerunning of test 
cases that end with a final result of “Incomplete” or “Failed”. 

• Rerunning Test Case Iterations: These parameters control the behavior of 
iteration-based test cases. 

NOTE: Because Data Throughput – LTE test packs are not iteration-based; these 
parameters are not used. 

• Reset UE between Test Cases: Resetting the UE between test cases can improve 
system performance and stability in some cases.  

NOTE: The Data Throughput – LTE test packs automatically reset the UE at various 
points during the test; it is not necessary to set this parameter to “True”. 

 
Figure 3-12: Session Parameters 
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3.4.2. eAirAccess Parameters 

eAirAccess parameters control the execution of eAA, as shown in Figure 3-13. 

• LTE L1/L2 Logging Enabled: This parameter enables or disables logging of 
eAirAccess L1/L2 messages. 

 
Figure 3-13: eAirAccess parameters 

3.5. Selecting the Parameter Files for Session Execution 

As indicated in the Test Manager User Manual, you cannot run a suite successfully 
unless it undergoes validation using the specified Platform, Session and UE Parameter 
files. 

In the Execute Session window, select the Session File, the UE File, and the Platform 
File. After the Platform File is selected, select the Platform as shown in Figure 3-14. 

 
Figure 3-14: Selecting Parameter Files for Data Throughput – LTE Module 
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3.6. Locating the Test Suites and Test Cases 

3.6.1. Locating Pre-defined Module Test Suites 

1. In the Test Manager, select the Suite Files tab in the File Cabinet and open the Suite 
Files folder tree. 

2. Open the LTE Data Throughput folder tree.  
All of the pre-defined Suites available for Data Throughput Testing display, as shown 
in Figure 3-15. 

 
Figure 3-15: Locating Data Throughput - LTE Module Pre-defined Suites 
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3.6.2. Locating Module Test Cases 

1. In the Test Manager, select the Test Folders tab in from the file Cabinet. 

2. Open the Test Folders folder.  

3. Open the LTE>Data Throughput subfolder. 
This folder contains the Data Throughput – LTE Test Cases, as shown in Figure 3-16. 

 
Figure 3-16: Data Throughput – LTE Test Cases 

3.7. Creating a Custom Test Suite 

To set up a custom Data Throughput – LTE test, you must create a Test Suite.  

To create a Test Suite: 

1. In the Test Manager Menu, select File>New>Suite File, as shown in Figure 3-17. 
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Figure 3-17: Creating a New Suite 

2. You can also use the toolbar shortcuts available to create a new file, as shown in 
Figure 3-18. 

 
Figure 3-18: Creating a Suite File using the Toolbar Shortcut 

3. A new Test Suite window opens with a default file name.  
This window allows you to sequence and arrange the tests. 

4. To add a test from the Data Throughput – LTE test packs, drag the desired test from 
the Module Files tab of the File Cabinet on the left and move it over to your Suite 
File on the right, as shown in Figure 3-19 and Figure 3-20. 
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Figure 3-19: Transferring a Test Case into a Suite 

 
Figure 3-20: Successfully Transferred Test Case 

5. Configure the parameters for each Test Case based on your testing needs.  
Refer to Section 3.6 and Chapter 4 for additional information on configuring Test 
Case Parameters. 

6. When you have completed adding and sequencing the test cases, save the Suite file. 
The custom suite file displays in the file cabinet, as shown in Figure 3-21. 
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Figure 3-21: Customized Suite Saved to the File Cabinet 
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3.8. Configuring Test Case Parameters 

1. In Test Manager, select the desired Test Suite from the Parameters tab in the File 
Cabinet. 

2. In the Suite Editor, select the Test Case, as shown in Figure 3-22. 

 
Figure 3-22: Configuring Test Case Parameters 

3. Select the appropriate defining parameters for the test. 
For more information on setting parameters, refer to Chapter 4. 

4. Save changes to the Suite File. 

3.9. Running a Test Suite 

After creating the custom test suite and configuring the test case parameters (refer to 
Section 3.6 on page 25 for details), or selecting a pre-defined test suite, you must 
ensure the suite passes validation. 

As discussed in the Test Manager User Manual, the key requirements to run a user-
defined suite are a valid Session, UE, and Platform file.  

To run the test suite: 

1. In the Test Manager, open the desired test suite from the Suite Files tab of the File 
cabinet, as shown in Figure 3-23. 
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Figure 3-23: Loading a Data Throughput – LTE Test Suite 

NOTE: Each Test Case in a pre-defined Suite has test case parameters configured to 
support the test definition. You do not have to alter them unless you are writing 
your own test suite. For more information on configuring test case parameters, refer 
to Section 3.6 on and Chapter 4: Test Reference. 

2. In the Test Manager menu, select Execute>Start Session>Run All Test Cases to start 
executing the entire Test Suite.  
You also have the option of executing only the currently selected test case. 
The Execute Session window displays. 

3. Select the appropriate parameter files and platform. For more information on 
selecting these files, refer to section 4.  

4. If desired, specify the Tester Name, UE Manufacturer, and UE Model. These fields 
display on all reports you create based on the results of this session. 

NOTE: The Results folder and Platform File selections are already set, it is not 
necessary to make changes to these fields. 
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5. Click OK to begin validation.  
If successful, the test session begins, as shown in Figure 3-24. 

 
Figure 3-24: Test Session in Progress 

3.10. Setting Up a New UE with the Data Client 

To introduce or setup a new UE (or swap between more than one) connected to the Data 
Client PC, you need to configure the system to establish data throughput connectivity 
from the Controller PC, as well as the Application server. While both the Data Client and 
the Application Server are connected by the Ethernet cable, the data transfer throughput 
must occur via the Network Emulator interface. 

To run a test with a new UE: 

1. On the Data Client laptop, install the manufacturer software/drivers for the new UE.  
The UE software should support an installation configurable as a tethered modem. 

NOTE: The Data Client laptop has a modem dial-up connection named TestDrive 
Data Connection configured for use with your UE. This is part of the installation and 
cannot be changed. 

2. The Data Client laptop is pre-configured to support Client Dial-up connections for the 
tethered modem-configured UE under Test.  
Use the TestDrive Data Connection Dial-up networking setting on the laptop to set 
up the UE. 

3. On the Data Client laptop, select Control Panel>Network Connections, right-click 
TestDrive Data Connection and select Properties, as shown in Figure 3-25. 
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Figure 3-25: Data Client Network Connections 

 
Figure 3-26: TestDrive Data Connections Properties Window – Selecting Current UE 

4. Under the General tab, shown in Figure 3-26, select the correct UE under Test in the 
Connect Using list. 

5. Refer to the UE specifications and enter the correct dial-in number.  
By default, the Data Client laptop is set to a dial-in Number of *99#. Note that *99# 
is one of two AT Command GPRS specifications for a request to use the Packet 
Domain service. The other common dial-in number is *98#. 

6. Your new UE is now configured for testing.



4. Test Reference 

4.1. Overview 

This chapter describes the Data Throughput – LTE Module test cases in greater detail, 
including the algorithms implemented during test execution. 

The information is grouped into the following subsections: 

1. Test Suite Execution 

2. Data Throughput – LTE Test Cases 

3. Description of Data Throughput – LTE Module Test Parameters 

4.2. Test Suite Execution 

This section describes the sequence of operations performed during the execution of a 
Test Suite from the Test Manager. 

Validate Suite

Start Session

Connect to the Instruments

End Session

Success

Execute Tests

Disconnect from Instruments

Failure

Failure

Success

 
Figure 4-1: Test Suite Execution Flowchart 
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4.3. Data Throughput – LTE Test Cases 

This section describes the test cases that facilitate the Testing functionality of the Data 
Throughput – LTE Test Packs.  

1. FTP Transfer Throughput – Test 

2. UDP Transfer Throughput –  Test 

3. Application Layer Throughput Stress  - Test 

4. Control Plane Timing –  Test 

5. User Plane Latency –  Test 

6. UDP Power Sweep - Test 

4.3.1. FTP Transfer Throughput – Test 

4.3.1.1 Description 

This test case is designed to evaluate LTE Data Throughput performance of the UE during 
a LTE data call. Once the initial conditions are configured, the system waits to detect the 
initial network attach. Following the network attach, different parameters are configured 
such as RF impairments (AWGN, Fade Profile, MIMO), using configurable Resource Block 
Allocations.  

If SVLTE is enabled, this test case is designed to evaluate LTE Data Throughput 
performance of the UE during a LTE Data Call and a 1xRTT Voice Call. The parameters 
“CDMA 1xRTT Enabled” and “Call Enabled” should be set to True to support SVLTE. After 
configuring the initial conditions, the system waits to detect the initial network attach. 
Following the network attach, different parameters can be configured; such as RF 
impairments (AWGN, Fade Profile, MIMO), using configurable Resource Block 
Allocations. 

If Advanced/Dynamic Models is enabled, this test case evaluates LTE Data Throughput 
with integration of SR5500M to enable advanced channel emulation. You can select the 
.wce file where all Fading and Noise parameters are set. 

NOTE: If you use a Windows XP laptop and Application Server with a Windows 2003 
server, the maximum throughput in IPv6 will be lower than expected.  
This is because Microsoft does not support TCP window scaling for IPv6 on those 
platforms. 
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4.3.1.2 Required Test Equipment 

This test requires the following equipment: 

• LTE Network Emulators: Depending on the technologies specified in the configured 
scenarios. 

• CDMA 1xRTT Network Emulators: Depending on the parameters specified in the 
configured scenarios. 

• SR8078 TCU: Depending on the parameters specified in the configured scenarios. 

• SR5500M: Depending on the parameters specified in the configured scenarios. 

4.3.1.3 Test Parameters 

The following test parameters are supported for this test. 

Test Parameters 

General • Description 

Network Configuration • Configuration File Path 

• PDN Gateway 

o PDNs 

 PDN 
 IP Address Type  
 Default Barer QCI  
 Enable Dedicated Bearers  

• eNodeB 1 
o Operating Band 

o Downlink Channel Number 

o Downlink Bandwidth 

o MCC 

o MNC 

o RLC 

 Mode 

o MAC 

 Downlink Reference Channel 

• Scheduling Module 

• RB Allocation 

• Allocated RBs 

• Modulation 

• TBSize 
 Uplink Reference Channel 

• Scheduling Module 

• RB Allocation 

• Allocated RBs 

• Modulation 

• TBSize 

o Physical 
 RSTP 



34 | 8100: Data Throughput – LTE User Manual 

Test Parameters 
 Transmission Mode 

 CFI 
 UE Specific Search Space Aggregation 

 EPRE Ratios 

• Synchronization Signals 

o PSS RA 

o PSS RB 
o SSS RA 

o SSS RB 

• Control Channels 
o PBCH RA 

o PBCH RB 

o PCFICH RA 
o PCFICH RB 

o PDCCH RA 

o PDCCH RB 

o PHICH RA 
o PHICH RB 

• Shared Channels 
o PDSCH RA 

o PDSCH RB 

• CQI Parameters 

o CQI Reporting Type 
o Periodic CQI - ConfigIndex 
o CQI Reporting Channel 
o CQI Feedback Type 
o CQI Reporting Mode 
o Default Imcs for CW1 
o Default Imcs for CW2 
o CQI Mapping Type 
o CQI Mapping File Path 

• CDMA 1xRTT 
o CDMA 1xRTT Enabled 
o SID 
o NID 
o Band Class 
o Channel Number 
o Radio Configuration 
o Service Options 
o Power Control 
o RF  Power Level 

Channel Conditions • Advanced/Dynamic Models 

• SR5500 Configuration File 

• Fade Model 
o MIMO Correlation 

o MIMO Correlation Matrix Alpha 

o MIMO Correlation Matrix Beta 
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Test Parameters 
• Noise Enabled 

o Noc 

o SNR 

• Final RSTP(dBm/15kHz) 

Test Options • Number of Transfers 

• Transfer Direction 

• FTP Optimization Enabled 

• Max Transfer Duration 

• Download File Name 

• Upload File Name 

• Voice Call Options 
o Call Enabled 

o Call Direction 
o Call Duration 

o Delay Between Calls 

Test Criteria • Advanced Criteria Enabled 

• Cat 1 Required Downlink Throughput 

• Cat 2 Required Downlink Throughput 

• Cat 3 Required Downlink Throughput 

• Cat 4 Required Downlink Throughput 

• Cat 5 Required Downlink Throughput 

• Cat 1 Required Uplink Throughput 

• Cat 2 Required Uplink Throughput 

• Cat 3 Required Uplink Throughput 

• Cat 4 Required Uplink Throughput 

• Cat 5 Required Uplink Throughput 

• Minimum Downlink Throughput 

• Minimum Uplink Throughput 

• Transfer Check Criteria 

• Require Data Integrity 

• Early Termination Enabled 

Logging Options • CQI Stats Enabled 

• RLC Layer Stats Enabled 

Advanced Options • Downlink Socket Buffer Size 

• Uplink Socket Buffer Size 

4.3.1.4 Test Results 

The following results are generated for this test: 

• Pass/Fail 
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4.3.1.5 Pass / Fail Criteria 

Testing Scenario Test Result 

The test completes performing average throughput exceeding the 
Minimum Downlink (Uplink) Throughput. If SVLTE is enabled, the voice 
calls all succeed or fail once. 

Pass 

The test completes performing average throughput not meeting the 
Minimum Downlink (Uplink) Throughput. If SVLTE is enabled, the voice 
call failed twice can also cause the case to have a “Fail” result. 

Fail 

The test cannot complete due to UE/Network Failures or an unknown 
failure. 

Incomplete (Other) 

4.3.2. UDP Transfer Throughput – Test 

4.3.2.1 Description 

This test case is designed to evaluate UE’s LTE data throughput performance during a 
LTE data call. Once the initial conditions are configured, the system waits to detect the 
initial network attach. Following the network attach, different parameters are configured 
such as RF impairments (AWGN, Fade Profile, MIMO), using configurable Resource Block 
Allocations.  

If SVLTE is enabled, this test case is designed to evaluate LTE Data Throughput 
performance of the UE during a LTE Data Call and a 1xRTT Voice Call. The parameters 
“CDMA 1xRTT Enabled” and “Call Enabled” should be set to True to support SVLTE. After 
configuring the initial conditions, the system waits to detect the initial network attach. 
Following the network attach, different parameters can be configured; such as RF 
impairments (AWGN, Fade Profile, MIMO), using configurable Resource Block 
Allocations. 

If Advanced/Dynamic Models is enabled, this test case evaluates LTE Data Throughput 
with integration of SR5500M to enable advanced channel emulation. You can select the 
.wce file where the Fading and Noise parameters are set. 

4.3.2.2 Required Test Equipment 

This test requires the following equipment: 

• LTE Network Emulators: Depending on the technologies specified in the configured 
scenarios. 

• CDMA 1xRTT Network Emulator: Depending on the parameters specified in the 
configured scenarios. 

• SR8078 TCU: Depending on the parameters specified in the configured scenarios. 

• SR5500M: Depending on the parameters specified in the configured scenarios. 
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4.3.2.3 Test Parameters 

The following test parameters are supported for this test. 

Test Parameters 

General • Description 

Network 
Configurati
on 

• Configuration File Path 
• PDN Gateway 

o PDNs 

• PDN 

• IP Address Type 
• Default Barer QCI 
• Enable Dedicated Bearers  
• eNodeB 1 

o Operating Band 

o Downlink Channel Number 

o Downlink Bandwidth 

o MCC 

o MNC 

o RLC 

 Mode 

o MAC 

 Downlink Reference Channel 

• Scheduling Module 

• RB Allocation 

• Allocated RBs 

• Modulation 

• TBSize 
 Uplink Reference Channel 

• Scheduling Module 

• RB Allocation 

• Allocated RBs 

• Modulation 

• TBSize 
o Physical 

 RSTP 

 Transmission Mode 

 CFI 
 UE Specific Search Space Aggregation 
 EPRE Ratios 

• Synchronization Signals 
o PSS RA 

o PSS RB 
o SSS RA 

o SSS RB 

• Control Channels 
o PBCH RA 

o PBCH RB 

o PCFICH RA 
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Test Parameters 
o PCFICH RB 
o PDCCH RA 

o PDCCH RB 

o PHICH RA 

o PHICH RB 

• Shared Channels 

o PDSCH RA 
o PDSCH RB 

• CQI Parameters 
o CQI Reporting Type 
o Periodic CQI - ConfigIndex 
o CQI Reproting Channel 
o CQI Feedback Type 
o CQI Reporting Mode 
o Default Imcs for CW1 
o Default Imcs for CW2 
o CQI Mapping Type 
o CQI Mapping File Path 

• CDMA 1xRTT 
• CDMA 1xRTT Enabled 
• SID 
• NID 
• Band Class 
• Channel Number 
• Radio Configuration 
• Service Options 
• Power Control 

o RF  Power Level 

Channel 
Conditions 

• Advanced/Dynamic Models 
• SR5500 Configuration File 

• Fade Model 
• MIMO Correlation 
• MIMO Correlation Matrix Alpha 
• MIMO Correlation Matrix Beta 
• Noise Enabled 
• Noc 
• SNR 

• Final RSTP(dBm/15kHz) 

Test 
Options 

• Number of Transfers 

• Transfer Direction 

• Transfer Duration 

• Blaster Rate 

• Downlink Blaster Rate 

• Uplink Blaster Rate 

• Voice Call Options 
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Test Parameters 
o Call Enabled 
o Call Direction 

o Call Duration 

o Delay Between Calls 

Test 
Criteria 

• Advanced Criteria Enabled 
o Cat 1 Required Downlink Throughput 
o Cat 2 Required Downlink Throughput 
o Cat 3 Required Downlink Throughput 
o Cat 4 Required Downlink Throughput 
o Cat 5 Required Downlink Throughput 
o Cat 1 Required Uplink Throughput 
o Cat 2 Required Uplink Throughput 
o Cat 3 Required Uplink Throughput 
o Cat 4 Required Uplink Throughput 
o Cat 5 Required Uplink Throughput 

• Minimum Downlink Throughput 

• Minimum Uplink Throughput 

• Transfer Check Criteria 

• Require Data Integrity 

• Early Termination Enabled 

Logging 
Options 

• CQI Stats Enabled 
• RLC Layer Stats Enabled 

Advanced 
Options 

• Downlink Socket Buffer Size 
• Uplink Socket Buffer Size 
• IPv4 UDP Packet Size 
• IPv6 UDP Packet Size 

4.3.2.4 Test Results 

The following results are generated for this test: 

• Pass/Fail 

4.3.2.5 Pass / Fail Criteria 

Testing Scenario Test Result 

The test completes performing average throughput exceeding the 
Minimum Downlink (Uplink) Throughput. If SVLTE is enabled, the voice 
calls all succeed or fail once. 

Pass 

The test completes performing average throughput not meeting the 
Minimum Downlink (Uplink) Throughput. If SVLTE is enabled, the voice 
call failed twice can also cause the case to have “Fail” result. 

Fail 

The test cannot complete due to UE/Network Failures or an unknown 
failure. 

Incomplete (Other) 
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4.3.3. Application Layer Throughput Stress – Test 

4.3.3.1 Description 

This test case is designed to evaluate UE’s LTE data throughput performance during a 
LTE data call. Once the initial conditions are configured, the system waits to detect the 
initial network attach. Following the network attach, different parameters are configured 
such as RF impairments (AWGN, Fade Profile, MIMO), using configurable Resource Block 
Allocations.  

If SVLTE is enabled, this test case is designed to evaluate LTE Data Throughput 
performance of the UE during a LTE Data Call and a 1xRTT Voice Call. The parameters 
“CDMA 1xRTT Enabled” and “Call Enabled” should be set to True to support SVLTE. After 
configuring the initial conditions, the system waits to detect the initial network attach. 
Following the network attach, different parameters can be configured; such as RF 
impairments (AWGN, Fade Profile, MIMO), using configurable Resource Block 
Allocations. 

If Advanced/Dynamic Models is enabled, this test case evaluates LTE Data Throughput 
with integration of SR5500M to enable advanced channel emulation. You can select the 
.wce file where the Fading and Noise parameters are set. 

4.3.3.2 Required Test Equipment 

This test requires the following equipment: 

• LTE Network Emulators: Depending on the technologies specified in the configured 
scenarios. 

• CDMA 1xRTT Network Emulators: Depending on the technologies specified in the 
configured scenarios. 

• SR8078 TCU: Depending on the parameters specified in the configured scenarios. 

• SR5500M: Depending on the parameters specified in the configured scenarios. 
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4.3.3.3 Test Parameters 

The following test parameters are supported for this test. 

Test Parameters 

General • Description 

Network 
Configurati
on 

• Configuration File Path 
• PDN Gateway 
• PDNs 
• PDN 
• IP Address Type 
• Default Barer QCI 
• Enable Dedicated Bearers 

• eNodeB 1 
o Operating Band 
o Downlink Channel Number 

o Downlink Bandwidth 

o MCC 

o MNC 

o RLC 

 Mode 

o MAC 
 Downlink Reference Channel 

• Scheduling Module 

• RB Allocation 

• Allocated RBs 

• Modulation 

• TBSize 
 Uplink Reference Channel 

• Scheduling Module 

• RB Allocation 

• Allocated RBs 

• Modulation 

• TBSize 
o Physical 

 RSTP 

 Transmission Mode 
 CFI 
 UE Specific Search Space Aggregation 
 EPRE Ratios 

• Synchronization Signals 

o PSS RA 
o PSS RB 

o SSS RA 

o SSS RB 

• Control Channels 

o PBCH RA 

o PBCH RB 
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Test Parameters 
o PCFICH RA 
o PCFICH RB 

o PDCCH RA 

o PDCCH RB 

o PHICH RA 
o PHICH RB 

• Shared Channels 
o PDSCH RA 

o PDSCH RB 

• CQI Parameters 

o CQI Reporting Type 
o Periodic CQI - ConfigIndex 
o CQI Reproting Channel 
o CQI Feedback Type 
o CQI Reporting Mode 
o Default Imcs for CW1 
o Default Imcs for CW2 
o CQI Mapping Type 
o CQI Mapping File Path 

• CDMA 1xRTT 
• CDMA 1xRTT Enabled 
• SID 
• NID 
• Band Class 
• Channel Number 
• Radio Configuration 
• Service Options 
• Power Control 

o RF  Power Level 

Channel 
Conditions 

• Advanced/Dynamic Models 
• SR5500 Configuration File 

• Fade Model 
• MIMO Correlation 
• MIMO Correlation Matrix Alpha 
• MIMO Correlation Matrix Beta 
• Noise Enabled 
• Noc 
• SNR 

• Final RSTP(dBm/15kHz) 

Test 
Options 

• Stress Duration 

• Transfer Direction 

• Transfer Protocol 

• FTP Optimization Enabled 
• Max Transfer Duration 

• Download File Name  

• Upload File Name 
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Test Parameters 
• Transfer Duration  

• Blaster Rate 

• Downlink Blaster Rate 

• Uplink Blaster Rate 

• Voice Call Options 
o Call Enabled 

o Call Direction 

o Call Duration 

o Delay Between Calls 

Test 
Criteria 

• Advanced Criteria Enabled 
o Cat 1 Required Downlink Throughput 
o Cat 2 Required Downlink Throughput 
o Cat 3 Required Downlink Throughput 
o Cat 4 Required Downlink Throughput 
o Cat 5 Required Downlink Throughput 
o Cat 1 Required Uplink Throughput 
o Cat 2 Required Uplink Throughput 
o Cat 3 Required Uplink Throughput 
o Cat 4 Required Uplink Throughput 
o Cat 5 Required Uplink Throughput 

• Minimum Downlink Throughput 

• Minimum Uplink Throughput 

• Transfer Check Criteria 

• Require Data Integrity 

• Early Termination Enabled 

Logging 
Options 

• CQI Stats Enabled 
• RLC Layer Stats Enabled 

Advanced 
Options 

• Downlink Socket Buffer Size 
• Uplink Socket Buffer Size 
• IPv4 UDP Packet Size 
• IPv6 UDP Packet Size 

4.3.3.4 Test Results 

The following results are generated for this test: 

• Pass/Fail 

4.3.3.5 Pass / Fail Criteria 

Testing Scenario Test Result 

The test completes performing average throughput exceeding the 
Minimum Downlink (Uplink) Throughput. If SVLTE is enabled, the voice 
calls all succeed or fail once. 

Pass 
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Testing Scenario Test Result 

The test completes performing average throughput not meeting the 
Minimum Downlink (Uplink) Throughput. If SVLTE is enabled, the voice 
call failed twice can also cause the case to have “Fail” result. 

Fail 

The test cannot complete due to UE/Network Failures or an unknown 
failure. 

Incomplete (Other) 

4.3.4. Control Plane Timing – Test 

4.3.4.1 Description 

This test case is designed to measure the control plane latency of the UE from initial 
attachment to the network, and transition from RRC_Idle to RRC_Connected state. 

If Advanced/Dynamic Models is enabled, this test case evaluates the control plane 
latency of the UE with integration of SR5500M to enable advanced channel emulation. 
You can select the .wce file where the Fading and Noise parameters are set. 

4.3.4.2 Required Test Equipment 

This test requires the following equipment: 

• LTE Network Emulators: Depending on the technologies specified in the configured 
scenarios. 

• SR8078 TCU: Depending on the parameters specified in the configured scenarios. 

• SR5500M: Depending on the parameters specified in the configured scenarios. 

4.3.4.3 Test Parameters 

The following test parameters are supported for this test. 

Test Parameters 

General • Description 

Network Configuration  Configuration File Path 
 PDN Gateway 
 PDNs 
 PDN 
 IP Address Type 
 Default Barer QCI 
 Enable Dedicated Bearers 

 eNodeB 1 
o Operating Band 

o Downlink Channel Number 

o Downlink Bandwidth 
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Test Parameters 

o MCC 

o MNC 

o RLC 

 Mode 
o Physical 

 RSTP 

 Transmission Mode 
 CQI Reporting Type 
 Periodic CQI ConfigIndex 
 EPRE Ratios 
 Synchronization Signals 

o PSS RA 
o PSS RB 
o SSS RA 
o SSS RB 

 Control Channels 
o PBCH RA 
o PBCH RB 
o PCFICH RA 
o PCFICH RB 
o PDCCH RA 
o PDCCH RB 
o PHICH RA 
o PHICH RB 

 Shared Channels 
o PDSCH RA 
o PDSCH RB 

Channel Conditions • Advanced/Dynamic Models 
• SR5500 Configuration File 
• Fade Model 
• MIMO Correlation 
• MIMO Correlation Matrix Alpha 
• MIMO Correlation Matrix Beta 
• Noise Enabled 
• Noc 
• SNR 
• Final RSTP(dBm/15kHz) 

Test Options • Execution Limit 
• Iterations 
• Test Time 
• Latency Measurement 
• Initiation 

Test Criteria • Pass/Fail Measurement(s) 
• Maximum Connect Time 
• Maximum Attach Time 
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Test Parameters 

• Iteration Check Criteria 
• Early Termination Enabled 

Logging Options • CQI Stats Enabled 

4.3.4.4 Test Results 

The following results are generated for this test: 

• Pass/Fail 

4.3.4.5 Pass / Fail Criteria 

Testing Scenario Test Result 

The test completes performing average measurement time less than or 
equal to maximum connect (attach) time. 

Pass 

The test completes performing average measurement time more than 
maximum connect (attach) time. 

Fail 

The test cannot complete due to UE/Network Failures or an unknown 
failure. 

Incomplete (Other) 
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4.3.5. User Plane Timing – Test 

4.3.5.1 Description 

This test case is designed to evaluate the performance of the UE for user plane round trip 
delay. 

If Advanced/Dynamic Models is enabled, this test case evaluates the performance of the 
UE in user plane round trip delay with integration of SR5500M to enable advanced 
channel emulation. You can select the .wce file where the Fading and Noise parameters 
are set. 

4.3.5.2 Required Test Equipment 

This test requires the following equipment: 

• LTE Network Emulators: Depending on the technologies specified in the configured 
scenarios. 

• SR8078 TCU: Depending on the parameters specified in the configured scenarios. 

• SR5500M: Depending on the parameters specified in the configured scenarios. 

4.3.5.3 Test Parameters 

The following test parameters are supported for this test. 

Test Parameters 

General • Description 

Network Configuration • Configuration File Path 

• PDN Gateway 

o PDNs 
 PDN 

 IP Address Type 
 Default Barer QCI 
 Enable Dedicated Bearers 

• eNodeB 1 

o Operating Band 

o Downlink Channel Number 

o Downlink Bandwidth 

o MCC 

o MNC 

o RLC 

 Mode 

o MAC 
 Downlink Reference Channel 

• Scheduling Module 

• RB Allocation 
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Test Parameters 
• Allocated RBs 

• Modulation 

• TBSize 

 Uplink Reference Channel 

• Scheduling Module 

• RB Allocation 

• Allocated RBs 

• Modulation 

• TBSize 
o Physical 

 RSTP 

 Transmission Mode 
 CFI 
 UE Specific Search Space Aggregation 
 CQI Reporting Type 
 Periodic CQI ConfigIndex 
 EPRE Ratios 

• Synchronization Signals 

o PSS RA 
o PSS RB 

o SSS RA 

o SSS RB 

• Control Channels 
o PBCH RA 

o PBCH RB 
o PCFICH RA 

o PCFICH RB 

o PDCCH RA 

o PDCCH RB 
o PHICH RA 

o PHICH RB 

• Shared Channels 
o PDSCH RA 

o PDSCH RB 

Channel Conditions • Advanced/Dynamic Models 
• SR5500 Configuration File 
• Fade Model 
• MIMO Correlation 
• MIMO Correlation Matrix Alpha 
• MIMO Correlation Matrix Beta 
• Noise Enabled 
• Noc 
• SNR 
• Final RSTP(dBm/15kHz) 

Test Options • Execution Limit 
• Iterations 
• Test Time 
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Test Parameters 

• Ping Direction 
• Packet Size 

Test Criteria • Minimum Delay 
• Delay Check Criteria 
• Maximum Timeouts 
• Early Termination Enabled 

Logging Options • CQI Stats Enabled 

4.3.5.4 Test Results 

The following results are generated for this test: 

• Pass/Fail 

4.3.5.5 Pass / Fail Criteria 

Testing Scenario Test Result 

The test completes performing average round trip delay less than or 
equal to Minimum Delay. 

Pass 

The test completes performing average round trip delay more than 
Minimum Delay. 

Fail 

The test cannot complete due to UE/Network Failures or an unknown 
failure. 

Incomplete (Other) 

4.3.6. UDP Power Sweep – Test 

4.3.6.1 Description 

This test case is designed to measure UE’s data throughput variation by varying the 
power sweep. Once the initial conditions are configured, the system waits to detect the 
initial network attach. Once the initial conditions are configured, the system waits to 
detect the initial network attach. Following the network attach, different parameters are 
configured such as RF impairments (AWGN, Fade Profile, MIMO), using configurable 
Resource Block Allocations. 

If SVLTE is enabled, this test case is designed to evaluate LTE Data Throughput 
performance of the UE during a LTE Data Call and a 1xRTT Voice Call. The parameters 
“CDMA 1xRTT Enabled” and “Call Enabled” should be set to True to support SVLTE. After 
configuring the initial conditions, the system waits to detect the initial network attach. 
Following the network attach, different parameters can be configured; such as RF 
impairments (AWGN, Fade Profile, MIMO), using configurable Resource Block 
Allocations. 
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If Advanced/Dynamic Models is enabled, this test case evaluates LTE Data Throughput 
with integration of SR5500M to enable advanced channel emulation. You can select the 
.wce file where the Fading and Noise parameters are set. 

4.3.6.2 Required Test Equipment 

This test requires the following equipment: 

• LTE Network Emulators: Depending on the technologies specified in the configured 
scenarios. 

• CDMA 1xRTT Network Emulators: Depending on the technologies specified in the 
configured scenarios. 

• SR8078 TCU: Depending on the parameters specified in the configured scenarios. 

• SR5500M: Depending on the parameters specified in the configured scenarios. 

4.3.6.3 Test Parameters 

The following test parameters are supported for this test. 

Test Parameters 

General • Description 

Network Configuration • Configuration File Path 
• PDN Gateway 

o PDN 
 IP Address Type 
 Default Barer QCI 
 Enable Dedicated Bearers 

• eNodeB 1 
o Operating Band 
o Downlink Channel Number 
o Downlink Bandwidth 
o MCC 
o MNC 
o RLC 

 Mode 
o MAC 

 Downlink Reference Channel 
• Scheduling Module 
• RB Allocation 
• Allocated RBs 
• Modulation 
• TBSize 

 Uplink Reference Channel 
• Scheduling Module 
• RB Allocation 
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Test Parameters 

• Allocated RBs 
• Modulation 
• TBSize 

o Physical 
 RSTP Sweep Options 

• Initial RSTP 
• Final RSTP 
• Step 

 Transmission Mode 
 CFI 
 UE Specific Search Space Aggregation 
 EPRE Ratios 

• Synchronization Signals 
o PSS RA 
o PSS RB 
o SSS RA 
o SSS RB 

• Control Channels 
o PBCH RA 
o PBCH RB 
o PCFICH RA 
o PCFICH RB 
o PDCCH RA 
o PDCCH RB 
o PHICH RA 
o PHICH RB 

• Shared Channels 
o PDSCH RA 
o PDSCH RB 

• CQI Parameters 
o CQI Reporting Type 
o Periodic CQI - ConfigIndex 
o CQI Reproting Channel 
o CQI Feedback Type 
o CQI Reporting Mode 
o Default Imcs for CW1 
o Default Imcs for CW2 
o CQI Mapping Type 
o CQI Mapping File Path 

• CDMA 1xRTT 
o CDMA 1xRTT Enabled 
o SID 
o NID 
o Band Class 
o Channel Number 
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Test Parameters 

o Radio Configuration 
o Service Options 
o Power Control 
o RF  Power Level 

Channel Conditions • Advanced/Dynamic Models 
• SR5500 Configuration File 
• Fade Model 
• MIMO Correlation 
• MIMO Correlation Matrix Alpha 
• MIMO Correlation Matrix Beta 
• Noise Enabled 
• Noc 
• SNR 

Test Options • Number of Transfers 
• Transfer Direction 
• Transfer Duration 
• Blaster Rate 
• Downlink Blaster Rate 
• Uplink Blaster Rate 
• Voice Call Options 

o Call Enabled 
o Call Direction 
o Call Duration 
o Delay Between Calls 

Test Criteria • Advanced Criteria Enabled 
• Minimum Downlink (Uplink) Throughput 
• Minimum Downlink (Uplink) Throughput with UE Category 
• Transfer Check Criteria 
• Require Data Integrity 
• Early Termination Enabled 

Logging Options • CQI Stats Enabled 
• RLC Layer Stats Enabled 

Advanced Options • Downlink Socket Buffer Size 
• Uplink Socket Buffer Size 
• IPv4 UDP Packet Size 
• IPv6 UDP Packet Size 

4.3.6.4 Test Results 

The following results are generated for this test: 

• Pass/Fail 



Chapter Four: Test Reference | 53 

4.3.6.5 Pass / Fail Criteria 

Testing Scenario Test Result 

The test completes performing average throughput exceeds the 
Minimum Downlink (Uplink) Throughput for each RSTP value. If SVLTE is 
enabled, the voice calls all succeed or fail once. 

Pass 

The test completes performing average throughput does not meeting the 
Minimum Downlink (Uplink) Throughput for each RSTP value. If SVLTE is 
enabled, if the voice call fails twice, it can cause the test case to have a 
“Fail” result. 

Fail 

The test cannot complete due to UE/Network Failures or an unknown 
failure. 

Incomplete (Other) 
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4.4. Description of Data Throughput – LTE Module Test 
Parameters 

Most testing tasks can be accomplished using the defined User Test Suites. For 
individual testing needs, you can create custom Test Suites using the Module Test Cases 
and user-defined parameters.  

You can change the following Test Parameters to define your testing needs:  

• Network Configuration 

• Channel Conditions 

• Test Options 

• Test Criteria 

These parameters are described in detail in the following sections. 

4.4.1. General 

Parameter 

Description 
Specifies a short description for the test case. 

4.4.2. Network Configuration 

Parameter 

Configuration File Path 
Specifies the eAirAccess Configuration File to be loaded. This file contains the configuration 
details of the eNodeB, MME, PGW, HSS and SGW. 

PDN Gateway 
PDNs  IP Address Type 
Specifies the type of PDN to configure. Valid Values: IPv4, IPv6. 
PDNs  Default Bearer QCI 
Specifies QCI for the default bearer. Valid Range: 1 to 9. 
PDNs  Enable Dedicated Bearers 
Enables or disables the use of dedicated bearers. 
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Parameter 

eNodeB 1 
eNodeB 1 Operating Band 
Sets the operating band. Supported Band is 1, 2, 4, 7, 10, 13, 14 and 17. 
eNodeB 1 Downlink Channel Number 
Sets the downlink channel number. 
eNodeB 1 Downlink Bandwidth 
Sets the downlink bandwidth (MHz). 
eNodeB 1 Security Information 
Sets the Security information. 
eNodeB 1 MCC 
Sets the MCC. 
eNodeB 1 MNC 
Sets the MNC. 
eNodeB 1 RLC 
Sets the operating band. 
    RLC-> Mode 

Sets the RLC transmission modes. 

eNodeB 1 MAC 
    MAC->Downlink Reference Channel->Scheduling Mode 

Sets the Scheduler Mode. 
    MAC->Downlink Reference Channel->RB Allocation 

Sets the Resource Block Allocation type. 
    MAC->Downlink Reference Channel->Allocated RBs 

Sets the number of Resource Blocks to be allocated. 
    MAC->Downlink Reference Channel->Start RB 

Sets the starting index for Resource Block Allocation. 
    MAC->Downlink Reference Channel->Modulation 

Specifies the Modulation type. 
    MAC->Downlink Reference Channel->TBSize 

Specifies the TBSize type. 
    MAC->Uplink Reference Channel->Scheduling Mode 

Sets the Scheduler Mode. 
    MAC-> Uplink Reference Channel->RB Allocation 

Sets the Resource Block Allocation type. 
    MAC-> Uplink Reference Channel->Allocated RBs 

Sets the number of Resource Blocks to be allocated. 
    MAC-> Uplink Reference Channel->Start RB 

Sets the starting index for Resource Block Allocation. 
    MAC-> Uplink Reference Channel->Modulation 

Specifies the Modulation type. 
    MAC-> Uplink Reference Channel->TBSize 

Specifies the TBSize type.     
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Parameter 

eNodeB 1 Physical 
    Physical -> RSTP 

Sets the Reference Signal Transmit Power (dBm). 
    Physical -> Reference Signal Ratio 

Sets the cell-specific reference signal power ratio (Ers/Ior) in dB. 
    Physical -> Transmission Mode 

Sets the transmission mode. 
    Physical -> CFI 

Sets the CFI value. 
    Physical -> Aggregation Level 

Sets the UE-Specific Search Space Aggregation (in CCEs). 
    Physical -> CQI Parameters -> CQI Reporting Type 

Set the CQI Reporting Type 
    Physical -> CQI Parameters -> Periodic CQI - ConfigIndex 

Set the CQI Configure Index 
    Physical -> CQI Parameters -> CQI Reporting Channel 
    Set the CQI Reporting Channel 
    Physical -> CQI Parameters -> CQI Feedback Type 
    Set the CQI Reporting Feedback Type 
    Physical -> CQI Parameters -> CQI Reporting Mode 
    Indicates the CQI Reporting Mode 
    Physical -> CQI Parameters -> Default Imcs for CW1 
    Set the default Imcs for CW1 if no CQI reported 
    Physical -> CQI Parameters -> Default Imcs for CW2 
    Set the default Imcs for CW2 if no CQI reported 
    Physical -> CQI Parameters -> CQI Mapping Type 
    Set the CQI Mapping Type 
    Physical -> CQI Parameters -> CQI Mapping File Path 
    Set the CQI Mapping File Path 

Physical -> EPRE Ratios -> Synchronization Signals -> PSS RA 
Specifies the PSS-to-RS EPRE ratio (Pa)in Db. 
Physical -> EPRE Ratios -> Synchronization Signals -> PSS RB 
Specifies the PSS-to-RS EPRE ratio (Pb)in Db. 
Physical -> EPRE Ratios -> Synchronization Signals -> SSS RA 
Specifies the SSS-to-RS EPRE ratio (Pa) in Db. 
Physical -> EPRE Ratios -> Synchronization Signals -> SSS RA 
Specifies the SSS-to-RS EPRE ratio (Pb) in Db. 
Physical -> EPRE Ratios -> Control Channels -> PBCH RA 
Specifies the PBCH-to-RS EPRE ratio (Pa) in Db. 
Physical -> EPRE Ratios -> Control Channels -> PBCH RB 
Specifies the PBCH-to-RS EPRE ratio (Pb) in Db. 
Physical -> EPRE Ratios -> Control Channels -> PCFICH RA 
Specifies the PCFICH-to-RS EPRE ratio (Pa) in Db. 
Physical -> EPRE Ratios -> Control Channels -> PCFICH RA 
Specifies the PCFICH-to-RS EPRE ratio (Pb) in Db. 
Physical -> EPRE Ratios -> Control Channels -> PDCCH RA 
Specifies the PDCCH-to-RS EPRE ratio (Pa) in Db. 
Physical -> EPRE Ratios -> Control Channels -> PDCCH RA 
Specifies the PDCCH-to-RS EPRE ratio (Pb) in Db. 
Physical -> EPRE Ratios -> Control Channels -> PHICH RA 
S ifi  h  PHICH RS EPRE i  (P ) i  Db  
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Parameter 

CDMA 1Xrtt 
CDMA 1Xrtt  CDMA 1Xrtt Enabled 
Enable or disable CDMA 1Xrtt.     
CDMA 1Xrtt  SID 
Sets the SID for CDMA 1Xrtt. 
CDMA 1Xrtt  NID 
Sets the NID for CDMA 1Xrtt. 
CDMA 1Xrtt  Band Class 
Sets the Band Class for CDMA 1Xrtt. 
CDMA 1Xrtt  Channel Number 
Sets the Channel Number for CDMA 1Xrtt. 
CDMA 1Xrtt  Radio Configuration 
Sets the Radio Configuration for CDMA 1Xrtt. 
CDMA 1Xrtt  Service Options 
Sets the Service Options for CDMA 1Xrtt. 
CDMA 1Xrtt  Power Control 
Sets the Power Control for CDMA 1Xrtt. 
CDMA 1Xrtt  RF Power level 
Sets the BTS Power Level (dBm). 

4.4.3. Channel Conditions 

Parameter 

Advanced/Dynamic Models 
Sets the Advanced/Dynamic Models. Valid Values: Yes, No 

SR5500M Configuration File 
Specifies the SR5500M Configuration File to be loaded. 

Fade Model 
Sets the use of standard LTE fade models. Available profiles: EVA5, EPA5,ETU70, EVA70, HST 

MIMO Correlation 
Sets the MIMO correlation. Valid Values: Low, Medium High 

MIMO Correlation Matrix Alpha 
Sets the Alpha value of MIMO Correlation Matrix 

MIMO Correlation Matrix Beta 
• Sets the Beta value of MIMO Correlation Matrix 

Noise Enabled 
Enables or disables the noise. 

Noc 
Sets the power spectral density (dBm/15KHz) of a white noise source as measured at the UE 
antenna connector. 

SNR 
Sets the cumulative Signal to Noise Ratio (Db) for UE Channel(s). 
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Parameter 

Final RSTP 
Display the final RSTP after setting SNR and fading (dBm/15kHz). 

4.4.4. Test Options 

Parameter 

Iterations 
Sets the number of times to perform the file transfer. 

Test Time 
Sets the duration to perform the transfers (minutes). 

Transfer Direction 
Sets the transfer direction from the perspective of the client application. 

Transfer Duration 
Sets the duration to transmit UDP packets (seconds). 

FTP Optimization Enabled 
Enables or disables FTP optimization which limits the maximum transfer duration of an FTP 
transfer. (When enabled, The Data Integrity check will be disabled.) 

Max Transfer Duration 
Specifies the maximum duration (seconds) that an FTP transfer will be allowed to run. 

Download File Name 
Specifies the file to download. Files requested for download must be stored in the 
“C:\Inetpub\ftproot\Spirent\APEX-FTP\Download” directory on the application server. 

Upload File Name 
Specifies the file to upload. Files requested for upload must be stored in ‘C:\Program 
Files\Spirent Communications\Spirent Data Client\Upload Files’ on the client laptop. 

Voice Call Options 
Sets the Voice Call Related Parameters. 
Voice Call Options  Call Enabled 
Enables/disables the Simultaneous Voice Call. 
Voice Call Options  Call Direction 
Set the Mode of Voice Call. 
Voice Call Options  Call Duration 
Set the Duration of Voice Call. 
Voice Call Options  Delay Between Calls 
Set the Delay Between two Voice Calls. 

Execution Limit 
Determines if the test will perform a specified number of iterations or repeat for a specified 
duration. 

Latency Measurement 
Sets the latency measurement type. 

Initiation 
Set the initiation of the connection. 



Chapter Four: Test Reference | 59 

Parameter 

Ping Direction 
Sets the ping direction from the perspective of the client application. 

Packet Size 
Sets the size of the ping packet to transmit during the test (bytes). 

4.4.5. Test Criteria 

Parameter 

Advanced Criteria Enabled 
• Enable/Disable the advanced criteria for multiple UE categories 

Cat 1 Required Downlink Throughput 
• Set the downlink throughput criteria for UE Category 1 

Cat 2 Required Downlink Throughput 
• Set the downlink throughput criteria for UE Category 2 

Cat 3 Required Downlink Throughput 
• Set the downlink throughput criteria for UE Category 3 

Cat 4 Required Downlink Throughput 
• Set the downlink throughput criteria for UE Category 4 

Cat 5 Required Downlink Throughput 
• Set the downlink throughput criteria for UE Category 5 

Cat 1 Required Uplink Throughput 
• Set the uplink throughput criteria for UE Category 1 

Cat 2 Required Uplink Throughput 
• Set the uplink throughput criteria for UE Category 2 

Cat 3 Required Uplink Throughput 
• Set the uplink throughput criteria for UE Category 3 

Cat 4 Required Uplink Throughput 
• Set the uplink throughput criteria for UE Category 4 

Cat 5 Required Uplink Throughput 
• Set the uplink throughput criteria for UE Category 5 

Maximum Connect Time 
• Defines the maximum connect time to pass the test (ms). 

Maximum Attach Time 
• Defines the maximum attach time to pass the test (ms). 

Maximum Delay 
• Defines the maximum delay to pass the test (ms). 

Maximum Timeouts 
• Defines the maximum number of timeouts allowed to pass the test. 
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4.4.6. Logging Options 

Parameter 

CQI Stats Enabled 
Enables/disables the CQI Statistics. 

RLC Layer Stats Enabled 
Enables/disables the RLC Layer Statistics. 

4.4.7. Advanced Options 

Parameter 

Uplink Socket Buffer Size 
Sets the Socket Buffer Size for Uplink. 

Downlink Socket Buffer Size 
Sets the Socket Buffer Size for Downlink. 

IPv4 UDP Packet Size 
Sets UDP packet size for IPv4. 

IPv6 UDP Packet Size 
Sets UDP packet size for IPv6. 
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